


The Publisher School                    Class #221 Editing Pictures for Books using Photoshop   2

Class #221 Editing Pictures for Books using Photoshop
Lesson Plan

Name of Student ___________________________

Date of Class Completion _____________________

Instructor ________________________________



The Publisher School                    Class #221 Editing Pictures for Books using Photoshop   3

Editing Pictures for Books Using Adobe Photoshop
© Sheri Hauser 2024
© The Publisher School
Camp Verde, Arizona,  USA
ISBN  978-1-60789-204-5   1-60789-204-9
Published in United States of America
Copyright data available on file.
Hauser, Sheri, 1957-
Editing Pictures for Books Using Adobe Photoshop/Sheri Hauser
1. Publishing Books    2. Title

www.thepublisherschool.com

Copyright is held by The Publisher School. No part of this book may be reproduced 
in any form or by any electronic mechanical means including information storage 
and retrieval systems, without permission in writing from The Publisher School.



The Publisher School                    Class #221 Editing Pictures for Books using Photoshop   4

The Publisher School
Camp Verde, Arizona USA

2024

Sheri Hauser

Editing Photos for Books 
Using Adobe Photoshop

The Publisher School Lesson Plan 
#221 ♦ [MODERATE] Publishing Study Guide



The Publisher School                    Class #221 Editing Pictures for Books using Photoshop   5

Professional Publishing with an Emphasis on 6 X 9 Paperback Book

#100 ♦ Introduction 100 Questions to Decide if you Want to be a Publisher
#101 ♦ Publishing Foundation of a Professional Publisher
#102 ♦ Publishing Book Covers Good, Bad and Ugly
#104 ♦ Publishing Using KDP to Publish a Paperback
#201 ♦ Publishing Software and Formatting Books
#202 ♦ Publishing Coaching an Author Through the Process of Publishing a Book
#221 ♦ Photoshop Editing Pictures for Books using Photoshop

The Publisher School
www.thepublisherschool.com

The Publisher School provides up-to-date, accurate training for 
those who are seeking answers to publishing. Glorybound Publishing 
was established in 2005 by Sheri Hauser in Las Vegas, Nevada. After 
extensive education and experience publishing over 700 books, she is 
releasing a series of training manuals to educate book publishers. 
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Summary of the Course: 
Study Guide #221 covers areas used in Photoshop specific to publishing 
books. It will familiarize the student with tools commonly used for editing 
photos used in books and learning how to brighten, touch up, extend, and 
repair. 
Sections Outline PG
1 Examination of a 

Photo
Photo file types
CYMK, RGB, Gray Scale
Determine the Size of the Photo
Copyright
Straighten, Crop & Edge

7

2 Basic Color 
Touching

DPI VS Size
Image Levels
Image Hue & Saturation
Image Photo Filter
Filter Stylize

14

3 Photo Face Lift Straighten & Crop Photo
Check DPI/resolution & size
Remove Wires [clone tool]
Straighten the horizon and straighten the 
edges
Fix skin flaws [band aid tool]

25

4 Book Covers Selecting a book cover photo
Checking the source of the photo
Adequate DPI/resolution & size
Adjusting tones
Book cover template adjustment
Extending a photo
Setting the copyright

35

221 Outline
Editing Pictures for Books 
Using Adobe Photoshop
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Course: #221 ♦ Photoshop Length of Course: 4 2-hr classes    
Title: Editing Pictures for books using Adobe Photoshop

Description of Course:
321 is a Photoshop Lab that will familiarize the student with tools 
commonly used for editing photos used in books and learning how to 
brighten, touch up, extend, and repair.

Section 1

Material in the Course:
Examination of a Photo

Outline:
Photo file types
CYMK, RGB, Gray Scale
Determine the Size of the Photo
Copyright
Straighten, Crop & Edge
_________________

Photo File Types
There are several photo file types. Generally, they originate from specific 
software or usages. An easy way to see different file types is to open 
Photoshop, open a photo and attempt to re-save the photo using save-as. 
There will be a pull-down menu which populates below the item you are 
trying to save. In mine, there are 20+ types of ways to save a photo. This 
course focuses on photos used specifically for publishing books, so we will 
gear the study toward these and neglect the others. 
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All of those below can be easily used in books: 
•	 JPEG-The most commonly used photo option for saving a photo. It is 

easy to migrate across the software and internet. 
•	 GIF-An option, but generally, I convert it to a JPEG when exported 

for use in publishing.
•	 Photoshop PDF-The process of building a book cover is to combine 

the photos with fonts using InDesign and then save it [eventually] as 
a high-resolution PDF. These are done exporting through Photoshop. 

•	 PNG-Easy to convert into JPEG.
•	 TIFF-Same as above. 
•	 PSD- This is a layered photo. Anytime you add font to a photo, 

Photoshop will add an additional layer on the photo. If you want to 
preserve the opportunity to edit the lettering (or change your mind) 
then you can save the picture as a PSD. Note, the photo size of the 
file will grow with each additional layer, so it is not practical to save 
photos as a PSD because they are very large. Another aspect of PSD 
is if you want to put an item on a background and the edges are 
not square, you need to make the background disappear (the white 
gone) so it can be on another background. 

Show example of logo on white and as PSD.
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CYMK, RGB, Gray Scale
The easiest way to think of color is considering a desktop printer. There are 
four color cartridges used in common printers—CYMK. Respectably, they 
are cyan, yellow, magenta, and black. Don’t ask me why K stands for black. 
I looked it up on the Internet and seems nobody knows. It is what it is. 
CYMK is the standard for printing because, when you save the photo, the 
colors will be consistent with printing if saved in that format. Every color 
used in printing can be made using these four colors. [insert pic of CYMK]

RGB stands for red, green and blue. This color system is utilized on-line, 
and every color corresponds to an index code with a specific color mix. 
Again, the goal is to try to keep the colors consistent when the viewer is 
looking at them on-line. The note here is when you download a picture 
from the web, it may be RGB and should be converted to CYMK when it 
is used in files making books. This is easily done. Simply ‘save-as’ a CYMK 
file. 

Gray scale is black and white photos. If you are using older photos in a 
book, it is good practice to save them gray scale and check the levels to 
ensure the photo isn’t too light or dark when printed. Remember, if a book 
is printed in black and white, even though you may use color photos, they 
will end up black and white in the final copy, so you may as well have 
control over the outcome by saving them in gray scale. 

Let’s practice with some photos. 
1. Open the color photo. 
2. Convert to Gray Scale.
3. Adjust the output levels.
4. Save.
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Determine the Size of the Photo
There are plenty of awesome pictures on social media, Facebook and 
through photo websites. If you see a picture which you may want to use 
for a project, the fi rst consideration is to check the size of the photo and 
the resolution. Pictures are formed using little squares of color. When you 
increase the size of the photo (go from 4 inches to 10 inches) each square 
of color becomes larger. It does not multiply the squares to fi ll in color. 
If you continue to enlarge the photo, you can see the squaring off  of the 
color chunks. The proper term for this is ‘pixilation’ of the photo. 

To determine how big the photo is: 
Image
Image Size
Height and Width and Resolution

There are two considerations with determining how big the photo is; Size 
and resolution. 
Size: The picture needs to be at least as big as you are trying to display 
it. If you are making a brochure and the picture displayed will be 3.5” x 
3.5” then a 6” photo will be OK. If the space you are displaying the photo 
in is 8 x 10 and the photo is 5 x 7, the photo will not look good. It will be 
pixilated—or blurry. 

Resolution: The resolution is how many little squares of color are 
contained in the entire picture. A picture can be 3.5” x 3.5” with a 
resolution of 75 dpi (dots per inch) or 3.5” x 3.5” with a resolution of 600 
dpi. The one with more wins. The dpi determines how clear the photo will 
appear. When a photo is small, it is not as important as when it is blown 
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up. Low dpi is more evident when on a poster than on a post card using 
the same picture. 

Relationship of dpi with size: A small photo 4” x 8” with a dpi of 300 can 
be used larger than its original size because as it gets larger and the dpi 
drops, it will still be somewhat clear. It will reach a point where it becomes 
blurry, but if you don’t press it too much, you should be able to use it in a 
lot of places. Most cameras [or cell phone cameras] are set with a low dpi 
[72] but a large size 48” x 54”. Generally, what you are creating will fit on 
a piece of paper, so you can decrease the size and increase the resolution. 
Standard print resolution is 200 dpi. Think of it like dye in water in 1 cup. 
If the dye is dark enough, you can pour it into a gallon and still have vivid 
color. However, if the dye is weak to start with (low resolution), then when 
you pour it into a gallon container and add enough water to make a 
gallon, it will be pale. 

Let’s look at some resolution of pictures and practice changing the dpi.  
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Copyright
Grabbing pictures off the internet can easily become an infringement 
of the copyright of the one who took the photograph. Therefore, it is 
essential to check the copyright of the photo prior to using it. 

There are several ways to copyright a photo. None of them are 100% 
secure and keep others from stealing the photo—but they are worth a try. 
Here are a few: 

•	 Put a little c in a circle with the date. © 2023 
•	 Embed the copyright into the piece using specialized software. It 

imprints the photo with a transparent identification of the author. 
https://www.visualwatermark.com/

•	 Put a transparency across the entire photo. Istock does this with 
photos that are viewed prior to purchase to stop the viewer from 
copying the photo without buying it. 

•	 Embed the copyright data into the metadata of the photo when it is 
‘saved’. 

•	 Show low resolution photos on-line. If you have products (like 
photos or book covers) you can use a low-resolution photo on the 
website and it will look just fine to the viewer, but if someone tries 
to download or copy it, the photo will be too small to be of any use. 
For example, book covers are generally 6”x 9” with a resolution of 
200dpi. When displaying the photos of our book covers, I make the 
‘cover’ 4”x6” with a dpi of 100. This way if someone tries to steal the 
cover, it will print small with low resolution. 
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Original was a photo and 
stylized photo make to 
look like a painting. 
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Let’s look at some photos and check their copyright status. 
Let’s embed a copyright into the metadata of a photo. 

Straighten, Crop and Edge

Straightening Photos
It is not uncommon to receive photos which are slightly no level. If the 
photographer snapped the picture quickly or wasn’t paying attention, 
often the photo is not level. Part of being a professional publisher is to 
display professional grade photographs. This means that the photos 
should be level!
To tell if they are level, find something flat in the photograph and look at 
it. Does it appear to be level? I reviewed a book once by a self-published 
author which had a ocean beach picture on the cover. The sunset was 
crooked! Do not endure this. Level your pictures. It’s easy. 
Let’s level some pictures using the perspective crop tool. 
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Cropping Photos
When cropping a photo ALWAYS save the original photo and re-name the 
cropped one. This way, if you decide to return to the original, it is possible! 
I save all the originals and put them in a file working on the other ones 
making edits. Sometimes as you edit, you get a long way from the original 
and, realize later you need to ‘do over’ and return to the prior one. It is 
much easier if you have saved it. 
To crop a photo, first recognize who the star of the photo is. Not every 
part of the photo can be the star—pick one. Generally, the center point of 
the photo is where the primary focus is, so that is where your star should 
end up. Just because the sky is pretty, doesn’t mean it needs to garner 
attention away from the star of the photo—which may be a horse. When 
I crop a photo, I consider the shape I will end up with, and if it meets the 
requirements of where I want to insert it. If I chop off all the sky, the photo 
will become long and skinny. Does my space accommodate this? 
It is possible to straighten and crop at the same time. When you hold the 
curser over the corners, the picture rotates. We will do it in a minute. 
If you crop and it doesn’t give the desired look, you can go back and re-
do it. Control Z brings you back to the prior state. If you would like more 
control in the history, open the history palate under Window>History 
and pull the curser backwards to the point where you want to re-do the 
process. 
Let’s crop some photos. 

Edge
Sometimes when you straighten the photo and crop it, the photo shows 
white on the edges. It can be filled in to look better. You don’t need to 
keep cropping it until you get ‘good’ photo, just use the clone tool and fill 
in the edges. I will show you how to do it. 
Using the clone tool to fill in the edges of a cropped photo. 
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Examination of a Photo

Outline:
Photo file types
CYMK, RGB, Gray Scale
Determine the Size of the Photo
Copyright
Straighten, Crop & Edge

Course: #221 ♦ Photoshop 
Lab 8x10  
Length of Course: 4 2-hr 
classes    
Title: Editing Pictures 
for books using Adobe 
Photoshop

Description of Course:
321 is a Photoshop Lab that will familiarize the student with tools 
commonly used for editing photos used in books and learning how to 
brighten, touch up, extend, and repair.

This photo was made ‘alive’ so the text will flow 
around it. 
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Section 2

Material in the Course:
Basic Color Touching

Outline:
DPI VS Size
Image Levels
Image Hue & Saturation
Image Photo Filter
Filter Stylize

_________________

A picture is only as good as its original. However, there are many things 
which can be done to enhance a photo. A perfect example are the photos 
we see ‘touched-up’ using Twitter applications. Pretty can be made to look 
even prettier with a few ‘tweeks’ of the photo.
Session 2 overviews some simple photo enhancements which can help art 
utilized in book files.   

DPI VS Size
DPI refers to dots-per-inch of a photo. As you recall, photos are made of 
little squares of color. If there are more dots per inch, then the photo will 
appear clean and clear to the eye. Less dots makes the photo look fuzzy. 
One of the goals of a professional publisher is to always present the books 
with the sharpest photos possible. I caution you not to go overboard with 
this. Most common cameras [and phone cameras] take low resolution [72 
dpi] large size photos [45”]. When using a phone, often it will ask how 
you want to send the photo. You can choose to send it low, medium, or 
high resolution. If you select low resolution, it will be a small photo with 
low resolution and send quickly. However, if you select high resolution, it 
will be a larger photo with high resolution and take a long time to send 
because the file is much larger. 
DPI can range from 72 to 1200. Oftentimes it is a trade off to use a large 
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photo with a low resolution [42” x 43” with 75 dpi] or [6” x 7” with 600 dpi]. 
It depends on the printed size which you will need when the project is 
released. If you need an eight by ten photo for a children’s book, then it is 
imperative the photo ends up at least 8”x10” with a dpi of 200. Otherwise, 
it will be fuzzy. 200dpi is adequate for printing. Saving the photos at a 
higher resolution, just makes the files fat and does not add to the book.
Let’s look at some photos. 

1. Large photo with a low dpi
2. Small photo with a high dpi
3. Large photo with a high dpi
4. Small photo with a low dpi

Which photo is the most usable for printing purposes? __________________

Image Levels
An image may appear dank or drab in its original state. It is generally easy 
to make the photo look [over-all] brighter by adjusting Image Levels in 
Photoshop. All of the colors become more saturated [or darker]. 
Again, please be reminded this course is not a color course, or a course on 
Photoshop, but a publishing course for those wishing to make photos look 
better in books. Adobe Photoshop has a bunch of courses on Photoshop, 
so if this interests you, take them. My sister is an artist and can draw 
using Photoshop. I can’t. However, I have learned to alter photos to my 
advantage, and it is enough to get by. 
To alter image levels:
Image > adjustments > levels
Input channels have little triangles which can be adjusted. A good 
standard is to get all of the color between the triangles. Here are some 
pictures. Let’s practice adjusting the Image Levels in Photoshop. 

Image Hue & Saturation
Image hue and saturation are also fairly simple to adjust in Photoshop. 
Again, SAVE THE ORIGINAL before you start adjusting, so if you hate the 
outcome, you can revert to the original photo and do-over. Generally, I 
make a separate folder and save all of the original photos. Then I make 
a different folder for the adjusted pieces. Another ‘trick’ I use for photo 
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adjustments is to label the second-generation photo with an ‘a’ or a ‘b’ 
after the original letters. For instance, if the original photo is 33457, then 
after I adjust the photo, I name it 33457-b. Now, now I know I am not 
working with the original, but a second generation. After I make further 
changes, I might re-name it 33457-c. This is especially helpful when 
colorizing clip art. For instance, I might be using flowers as a heading and 
opt to go with several colors of the same flower. The original flower file 
is called ‘daisy’. I colorize it yellow and call it ‘daisy-yellow’. Then the next 
one is called ‘daisy-blue’. They are all daisies from the original clip art, but 
variations of the same. The original un-colored version keeps the generic 
name. 
To alter Hue & Saturation:
Image>Adjustments> Hue/Saturation
Adjust the rockers which are under each color channel. 
Here are some pictures. Let’s practice adjusting the Hue & Saturation in 
Photoshop. 

An important aspect of adjusting photos is that the picture will only be as 
good as you can see it. What that means is that if you are trying to work 
from a small, cheap screen, then you cannot trust the adjustments which 

you are making actually help the picture. Computer screens come in a 
variety of resolutions—which generally correlate to cost of the screen. I 
suggest, prior to delving into a lot of color adjustments using Photoshop, 
you invest in a high-quality computer screen. If you cannot see the colors, 
you cannot adjust them with confidence. 
In my office, I have a secondary screen which is set on the table so authors 
can watch me working on their books. Initially, I purchased this when 
COVID hit to help create distance between authors and myself. I used to 
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have them look over my shoulder. The screen is set on a different desk and 
allows them to be separated from me as well as have their own space. I 
purchased the first one in Office Max while I was in the store walking by. 
When I attached it to my computer, I noticed whenever I turned it on, the 
resolution in my screen dropped. What I realized is the resolution in the 
secondary screen (dummy screen) was lower than my original screen and 
when I connected them both, they dropped to the lowest resolution (of 
whichever was the lowest). My desk screen actually became more blurry. 
When that screen died, I purchased a larger, higher resolution screen 
which matched the same resolution of my desk screen and do not have 
the problem any longer. 

The Hue & Saturation is fun to adjust when you have a sunrise or sunset 
and you want to change the tones a bit. It is easy to make it more red or 
blue by adjusting the hues. It doesn’t take much to change the tone, so go 
light on the adjustments. 

Image Photo Filter
The Image Photo Filter adjusts the overall color of the photo. Again it is 
fun to play with when you are looking for different tones. 
To use the Image Photo Filter:
Image>Adjustments>Photo Filter
Here are some pictures. Let’s practice using the Photo Filter in Photoshop. 

Filter Stylize
The filter stylize is one of the most fun filters to play with. A photo can be 
instantly turned into a painting, a mosaic or a stone.
Filter>stylize>select the filter
Let’s try Oil Painting. Be sure to check the box ‘preview’ to be able to look 
at the picture while working on it. 
Control Z is your friend. This is the keyboard shortcut for Edit-Undo. 
Whatever change you make can be undone with a couple of keystrokes. If 
you get too far into it and want to go backwards it is possible to backup 
using the history window. 
Go to Window> Locate the History and open the box. Move the tab 
backwards to the point where you would like to return to. If you get really 
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messed up, you can shut the photo fi le. It will ask if you want to save it. 
Say, “NO!” It will not save the changes you have made but revert to the 
original photo. Again, this is why I always save the original photos!

Recap of Section 2: 
Material in the Course:
Basic Color Touching

Outline:
DPI VS Size
Image Levels
Image Hue & Saturation
Image Photo Filter
Filter Stylize

All of these are examples of Clip art which can 
be quite useful in books. Easy to change their 
colors in Photoshop.
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Course: #221 ♦ Photoshop Lab 8x10  Length of Course: 4 2-hr classes    
Title: Editing Pictures for books using Adobe Photoshop

Description of Course:
321 is a Photoshop Lab that will familiarize the student with tools 
commonly used for editing photos used in books and learning how to 
brighten, touch up, extend, and repair.

Section 3

Material in the Course:
Photo Face Lift

Outline:
Straighten & Crop Photo
Check DPI/resolution & size
Remove Wires [clone tool]
Straighten the horizon and straighten the edges
Fix skin flaws [band aid tool]

Straighten & Crop Photo
Nothing can ruin a good photo quicker than being crooked. It is a 
common problem among older photos. Photoshop has an easy option to 
straighten a photo. 

Perspective crop tool>Drag the cursor across the photo to the desired size. 
When the cursor is just below the bottom corner it will become a rocker 
and can be pivoted. The photo has lines over it which help to straighten it 
up. I like to select something which I know has a straight side and base the 
straightening up on this. 

Let’s practice with some photos.
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Check DPI/resolution & size

Check the dpi and the size of the photos which you practiced with above.  
To check the dpi. 

Image> Image size
This will give the resolution [dpi] and the size of the photo. Remember, 
you can trade size for resolution. So, if the photo is larger than the size 
you need, but has a low dpi, you can make the photo smaller and increase 
the dpi. If the photo is smaller than you need, but has a high resolution 
[greater than 200] then you can trade in resolution for size. 

However, if the photo is small with a low resolution [ex: 1.5” x 1.5” with a 
resolution of 96] then you will not be able to use the photo in anything 
desired to print. It is OK for use in on-line elements, but not for printing. 

Let’s practice with some photos.

Remove Wires [clone tool]

Often photos have distracting 
elements which can be carefully 
removed and make the photo much 
better. Some just keep cropping the 
photo until they get the piece they 
need, but it may not be the best 
solution. 

Common elements to remove: 

•	 Distracting background 

•	 Wires

•	 Ex-husbands

•	 Alien ships

Let’s practice with some photos.
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Straighten the horizon and straighten the edges

Nothing is more distracting than a crooked horizon. However, often when 
you straighten the photo, it cuts into the picture. You can crop the picture 
further to get rid of the white edges, or you can use the clone tool to 
extend the photo along the edges. 

The clone tool
The clone tool is one of the most useful tools in the toolbox for a publisher 
because it enables you to add to pictures, get rid of distracting elements 
and extend what is needed. 

Let’s straighten a few pictures and extend the edges using the clone tool.

Fix skin flaws [band aid tool]

Another great tool in the box for a publisher is the band-aid tool. The 
clone tool ‘clones’ exactly where you click. It is great if you want more of 
the same of something. It is easy to ‘extend’ the bush in a picture using 
the clone tool. 

The band aid tool gathers pixels from the surrounding area and gives a 
composite mix of them to the point of your brush. It is perfect for repairing 
skin flaws. An important element with Photoshop is knowing when to use 
which tool. Control Z is your friend, because, if you start in with the clone 
tool and it looks awful, you can switch to the band aid tool and, perhaps, it 
will look better. 

Let’s practice on some photos. 
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Course: #221 ♦ Photoshop Lab 8x10  Length of Course: 4 2-hr classes    
Title: Editing Pictures for books using Adobe Photoshop

Description of Course:
321 is a Photoshop Lab that will familiarize the student with tools 
commonly used for editing photos used in books and learning how to 
brighten, touch up, extend, and repair.

Section 4

Material in the Course:
Book Covers

Outline:
Selecting a book cover photo
Checking the source of the photo
Adequate DPI/resolution & size
Adjusting tones
Book cover template adjustment
Extending a photo
Setting the copyright

Selecting a book cover photo

Covers are unique in that they are a combination of pictures (or line art) 
and words. They need to be elastic and able to expand up and down—in 
and out because they are featured at a variety of sizes when advertised. 
A book cover is most often viewed postage size. Generally, a book cover 
includes a photo touched up using Photoshop and words. If you attempt 
to build the cover using Word, it will have issues dealing with the photo 
(and you will fight with the picture). If you attempt to build the cover using 
Photoshop, the words will be entered into the project as if they are part 
of the photo. They will not be elastic when the cover is up-sized or down-
sized. The best software for building book covers in InDesign is because 
it retains the photos in original format and size as well as inserting text 
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which can vary in size and is stretchable (like Illustrator). 
Once the cover is built, it must be converted (exported) using Acrobat 
to become a PDF. This smashes the words into the picture and freezes 
everything, so it won’t move when viewed or printed. If you do not convert 
the cover from Word, Photoshop, or InDesign, it will move when printed or 
viewed on different screens. If anyone has attempted to insert pictures into 
Word, he/she knows what I mean when I say, “They move!”

The picture used for this 
cover was purchased on 
ISTOCK as a copyright 
released photo for 
$33.00. First I extended 
the photo by enlarging 
the canvas and cloning 
the background so the 
color continued to blend. 
I wanted it to be a wrap 
around cover. Then, I 
realized the tip of one 
of the swords was not in 
the photo. I went back to 
the website and saw they 
had a larger one with the tip of her sword in it. So, I copied just that part 
of the photo and attached it to the photo using Photoshop. The colors 
used for the base were taken from the photo using the eye dropper and 

sampling her fur. I selected 
Bleeding Cowboy font for 
the title because she looks 
battle worn. The font should 
match the topic. It would 
not be appropriate to select 
a modern font. The cover 
should accent the book, not 
detract from it. The cover 
was quite dark, so I needed 
to use white to enable the 
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font to show up. Yellow or white works OK for showing up on dark colors. 
Be careful to keep the lettering away from the edges. 

Things to be aware of when building a cover

Importance: The book cover says what is inside the book. Its purpose is to 
draw attention to what is inside the cover and the back. 
Needs to be positive. Book covers should not give any advertisement to 
the other side of the team.  If it is a story of someone’s life we do not want 
to focus on the negative, but the positive aspects of it. 

What a book cover is not:

•	 An advertisement. A cover does not exist apart from the 
manuscript. It only provides a front door entrance to what is inside.

•	 A lure. It is not supposed to be like a dangling lure in front of a fish. 
We are not trying to catch someone unaware to draw them into 
purchasing the book.

•	 A story. It is not a picture story of what the book is about.  Most of 
the time covers are seen in advertisements and they are postage size 
pictures. If the photos are too detailed, it will not be observed by 
most. 

•	 Actual, but representative. The cover is not actual but represents 
what is within the pages. If the story is on weddings, you don’t need 
a full-blown picture of a wedding on the cover, but something which 
represents a wedding. 
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With the book covers above, we purchased one picture and used a filter to 
generate three different colors. This makes them look like a set of books. 
I think of ‘sets of books’ to be like children around the dinner table. They 
should look similar, but not the same. Others should be able to tell they 
are related when they sit next to one another. 

Recognize that there is a character limitation with book pages regarding 
the width of the page. It is half the size of a standard notebook page. 

•	 All pictures must be separated from the main file and attached 
separately. Do not embed the pictures or the manuscript in the 
e-mail (as some Mac computers are prone to do). 

•	 Pictures need to be at least 200 pixels. 

•	 Formats of RGB, CYMK or INDEX COLOR are ok.

•	 Black and White or color are OK

Notes on Pictures

1. The author automatically owns the copyright of all the pictures he/she 
drew, painted or photos taken from camera. (Copyright law)

2. The cover can be built using photos, line art, colors, or paintings. 
Whatever the initial format of the art is in, it must be digitalized prior to 
making a cover. If it is a painting, a photo must be taken and touchup 
done to remove shadows, etc prior to trying to make a cover. What this 
means is that the picture must be scanned into the computer or you 
can take a photo of it and give the digital file to the one who is trying 
to build the cover. 

3. It is a good idea to make three or four covers and pick between them. 
The author needs to pick the cover, not his/her family, or friends. 

4. Don’t forget to give recognition to those who create covers (as a gift 
for the author). This is usually on the back of the front cover or in the 
fore matter pages. 

5. Covers for children’s books are made using one of the pictures which 
has been made for the book and developing it for use as a cover. 

6. The author needs to like the cover because it represents the book. 
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It is HIS or HERS. Don’t be afraid to tweak the cover until the author 
is REALLY happy with it. Maybe it needs to be a different color or a 
different shade. Keep working on it until you are both happy!

Checking the source of the photo
It is a good idea to check the source of the photo before beginning to 
work on it, because the photo copyright may not be available for the 
author to use. The Internet has expanded options for making lots of 
pictures available. However, as a publisher, you owe it to your author not 
to release a book cover containing a copyright owned by someone else. 
Part of the process of making and releasing the book cover is to ‘set the 
copyright’. If the picture already has a copyright [by someone else] then 
it is considered copyright infringement to claim a copyright which is not 
rightfully theirs. 

Checking the Photo

1. Ask the author where he/she got it?

2. Figure out who took the picture. If the author took the photo, then 
he/she owns the copyright to it. Generally, the one who took the 
picture owns the copyright. Cameras have data they attach to photos 
when they are taken. The data tells when the photo what taken and 
with which camera. It does not tell who was holding the camera!

3. General Internet photos: Was the photo obtained from the Internet? 
The Internet was originally started to provide an open source for 
people to draw from, consequently there are tons of photos on the 
Internet which are considered ‘open source’. Any photo which does 
not have a claimed copyright is OK to use. To check the copyright, 
simply turn the photo over—check the properties information. 

4. Facebook photos:  Any photos put on Facebook are copyright 
released because Facebook has a waver, they make the person sign 
when uploading a photo. Be aware that Facebook automatically 
degrades photos when they are uploaded to save their data storage 
space. So, if the photo was taken from Facebook, it may not be 
usable because of its low resolution. 
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5. Family photos: Many have photos in their possession that they don’t 
know who took the photo—they just ended up with it somewhere 
along the line. Old family photos fall into this category. If the photo 
is in the possession of the author and there doesn’t appear to be any 
contention, then I use the photo. Again, I ask the author where the 
photo came from. If he/she doesn’t know, then I give him a blanket 
statement to this effect, “If you can figure out who took the photo, 
we will give him credit.”
Generally, families are not concerned about sharing photos with one 
another and infringing on copyright, so it is more important to offer 
credit for the photo.  

6. A photo of a photo: Sometimes authors REALLY want a picture of 
something, so they take a photo of the picture. They figure that 
because they took the picture [with their own device] they now own 
the copyright. It is a bit of a stretch. I try to encourage authors to be 
original in their presentation, and not copy someone else. 

7. Local Sites: Historical sites, famous buildings and attractions are 
often a cover choice for authors. Again, steer them away from any 
photo which is copyrighted. They are welcome to go to the site and 
take their own photo to use in their book. The historical sites and 
famous buildings are not copyrighted. We are simply talking about 
pictures. 

Adequate DPI/resolution & size
We have discussed dpi previously, so this is a review. DPI, resolution, and 
size of the photo is one of the biggest challenges faced by a publisher. 
A picture may look great on a computer screen, but lousy when printed. 
Commonly, photos used for Internet purposes are 72 dpi and a small size 
2”x2”. Photos used for printing purposes should be 200 dpi. You can trade 
in dpi for size, increasing the dpi while decreasing the size. If we did this to 
the photo above, it would be 1”x1” with a dpi of 200. This is the size of a 
postage stamp!

Those with ‘fast upload knowledge’ make their photos small with low 
resolution. However, there are many photos on the Internet by individuals 
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who are not aware of upload speeds or don’t care. Cameras have settings 
which can be adjusted for high resolution or low resolution. Most cell 
phones [today] take photos of low resolution and, when the user desires 
to send the picture [use it] he is given a choice of high/medium/low 
indicating it will send quicker if it is low file size.

If an author has a photo he has taken with his own cell phone, then I 
encourage him to send it to me at the high resolution rather than low 
resolution.  

Adjusting tones
Let’s adjust some tones in pictures.

Book cover template adjustment
Book covers are, for the most part, wrap around—like a taco. The most 
impressive ones have the picture or design running all the way around the 
cover. Templates are general and based on page count. More pages need 
a thicker spine. 

A spine with less than 100 pages is very narrow and cannot accommodate 
a font size which is readable by most, so KDP has their spine limit set at 
less than 100 pages for a spine. The font size on 
a paperback with 100 pages is 11. I have found 
11 Arial to be the best.

Put some pictures on book cover templates and 
do adjusting. 

Extending a photo
Oftentimes the author will present with a 
beautiful photo for their cover which is just 
a little too short for one side when the main 
objects are centered on the front. I draw the 
center front lines and place the photo exactly 
where we want it to be taking care to keep the 
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This is the photo we 
started with. He wanted 
the guy holding his 
hands up to be on the 
front of the book, so 
we flipped the photo. In 
Photoshop 

Image > Image Rotation
>Vertical or Horizontal. 

Next we decided that we 
wanted the rainbow to 
go completely around 
the book. Well, it ended 
too early, so I cloned the 
rainbow and it continued 
to curve nicely. Also, 
the background needed 
to be added to, so I 
extended the canvas. 
Image > canvas

You can select pixels, 
measurement or 
percentage. I like to use 
percentage. I extend it 
white and add color. 

The last photo adjacent 
is our finished product. 
Looks Good! I will show 
the entire wrap around 
cover on the next page. 
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Overcoming 
A Health Crisis

PASTOR 
MARTIN PANGBURN

Finding the mindset for recovering health.
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Overcoming a Health Crisis is an arsenal of information 
to get you back on the road to health again during and 
after enduring the crisis of your life and your health. 
Our health is paramount to living life to the fullest and 
without it we just exist. 

I want to get you on the road to recovery, because you 
are a Masterpiece of the Master's hand.
Overcoming a Health Crisis is the story about traveling 
to other countries, picking up a wild tropical parasite 
that was most difficult to diagnose, resulting in multi-
ple TIA's and strokes. It is about resuming life again no 
matter the circumstance, pressing forward for answers, 
finding answers and help in the most unusual places 
outside of the typical medical community. 
The results have been a restored life. Read this story 
of incredible life and health challenges and how health 
was restored. It is a story of searching for answers and 
faith in God.

Working Area for front cover
Pink is danger zone. Last dotted 
line may be cut off. 
Find the center of the front up and 
down. 

Start by downloading the 
right size according to the 
page count and book size. 
Then open up a new InDe-
sign file. I generally go with 
letter size and then re-size as 
needed. Make 4 layers. The 
template will be on the lower 
layer and you do not want it 
to move, so after you set the 
template, lock the layer. Lay 
out the template and put it 
on the lower layer. Then add 
the measurement options 
putting them on the top layer. 
As a general rule, Size fonts 
for covers are 60’s. The author 
name slightly smaller 35-40. 
The smallest book KDP will 
permit and have a spine is 104 
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The History 
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Sean wanted stars on the logo, so we added some! Also the boy scout 
motto was too cluttered with all those papers in the background, so we 
cut it out to put it on the back which makes a cleaner presentation. 

This book was a hardbound 
190 page full-color Boy Scout 
History Book. Awesome proj-
ect. Note the template for the 
cover is similar, but with wider 
sides to accommodate wrap-
ping around the book board. 

The minimum for hardbound 
books with KDP is 87. We have 
found that putting two chil-
dren’s books together works 
well to make one hardbound 
book with a print price of 
around $12.00 per book, we 
can set the retail price at 
$19.95 and still make money 
for the author. It provides them 
with an option for hardbound 
books--which children love!
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This was a small book (as you 
can see from the cover tem-
plate). It is too short to have 
writing on the spine, so the 
cover continuously wraps 
around. I think of it like a taco!

She wanted to use her own 
photos, so we were challenged 
to make the print on the cover 
stand out. The music note on 
the back is her logo. 

Many times authors want their 
logo or symbol of a set of 
books on the cover. 

I do not recommend putting a 
price on the book cover be-
cause it could change due to 
print prices and Amazon will be 
liable for the sales cost printed 
on the cover.

If authors want to sell books 
locally, I print a sheet of price 
labels and they stick them on 
their books. It is good to have 
a price on the book, but not 
printed on the cover. 

And, never put anything over 
the area designated for the bar 
code. There is no advantage of 
printing your own bar code on 
a book when submitted to KDP. 
The one they print on the book 
includes the isbn and the asin. 
ISBN is the International 
Standard Book Number (from 
Bowkers) and the ASIN which is 
their inventory number. 
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print away from the edges so it won’t be cut off in the binding process. 

Then, I extend the photo. Practice. 

This book cover provides a good example of what is needed to develop a 
nice professional book cover. 

The colors, the background and the rainbow were extended to enable it to 
wrap around the spine.

The picture used for this children’s book cover 
was nearly perfect--because the artist is used 
to making pictures which work well in books. 
The spine wrapped around the book leaving the 
characters on the front and the back of the cover 
nearly centered. The only problem was the letter-
ing got lost in the water. We fixed the issue with a 
white square in the water. 
When you don’t know what else to do and the 
back ground it too busy, you can always add a 
solid color background and write on it. Easy Fix!
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Setting the copyright
The final step in making a book cover is setting the copyright for the 
author. It is important to set the copyright before turning the cover loose 
with the author (who will post it all over their social networks). 

A copyright symbol is easy to make in Word. Type a ( and then c and then ) 
ENTER. © 
It is also available as a glyph in most fonts.  

InDesign and Photoshop have similar fields for setting the copyright data. 
If you design something using InDesign and transfer it to Photoshop the 
copyright data will follow whatever you build. 

Process: 

File (at the top of the page)
>File Info 
>Document Title: Give the title of whatever it is
>Author: List the Author by his/her official name
>Author Title: Author
>Description: I generally copy the summary of the book
>Rating: Stars. I figure if I am handing out stars, why not get 5? 
>Description Writer: I list the author’s name
>Key Words: Must be words followed by a comma. Use basic subject 
items.
>Copyright: Yes
>Copyright Notice: EX:  © 2023 Glorybound Sounds
>Copyright Info URL: The question is, “Who can verify this copyright?” 
Generally, I put my website url in this spot, unless I am doing work for 
another publisher. Then I put their website. 
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Videos on YouTube

Indesign easy Video 1 – Introduction

InDesign Easy-Tools for a professional paperback by Sheri Hauser. This is video #1 of a set 
of short videos that accompany the book by the same title. This Introduction covers how to 
prepare files in the writing stage with the goal of publishing. What is the best software to write 
a book in? What is the best file foundation that leads in seamlessly to make a paperback book 
or a hardbound book? Subsequent videos will work through the steps of actually uploading a 
paperback book and an e-book with their covers to KDP. Just follow along.

Video link  https://youtu.be/q5NatVq8-Lo      Filename: indesign easy video 1.mp4

--------------------

Indesign Easy Video 2 - Let’s talk KDP

Indesign Easy-Tools for a professional paperback. This is video #2 in a series of videos that 
go along with the book by the same title. This video covers What is KDP? Advantages of 
KDP. Disadvantages of using KDP. Problems or errors with KDP. Video is by Sheri Hauser of 
Glorybound Publishing.

Video link   https://youtu.be/r5_04HXh6gE  Filename   indesign video 2.mp4

--------------------

InDesign Easy Video 3 - Errors Not Flagged by KDP

InDesign Easy Series of short videos that correlate with the Book “InDesign Easy” Tools for a 
professional paperback by Sheri Hauser. This is #3 Video. Errors Not Flagged by KDP include 
pictures with a mask, overprint of photos, cover missing, smashed fonts on an e-book, type too 
small, color is off. Part of the Lasertrain.

Video link   https://youtu.be/4o6s41PWXio   Filename: video 3.mp4

--------------------

InDesign Easy Video 4 - signing up to KDP

InDesign Easy Series of short videos that correlate with the Book "InDesign Easy" Tools for a 
professional paperback by Sheri Hauser. This is #4 Video. We will go to the website and register 
with KDP with the intent of publishing a book on Amazon.

Video link:  https://youtu.be/Ae5hQ6UcuOw   Filename:  video 4 signing onto KDP.mp4

--------------------
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InDesign Easy video 5- Tour of KDP

InDesign Easy Series of short videos that correlate with the Book "InDesign Easy" Tools for 
a professional paperback by Sheri Hauser. This is #5 Video- Tour of KDP. We will go to the 
website and tour the tabs to understand their presentation. We will look at the bookshelf, 
check on the royalties, books sold and how to contact KDP. 

Video link:  https://youtu.be/WawrJc8_s6A Filename: video 5 Tour of KDP.mp4

--------------------

InDesign Easy video 6-What Sells Your Book

InDesign Easy Series of short videos that correlate with the Book "InDesign Easy" Tools for a 
professional paperback by Sheri Hauser. This is #6 Video-What Sells Your Book. The video gives 
a walk-through Amazon to show why certain books may be selling better than others. The 
video caps with showing how to fi nd your books’ url and put it on Facebook. 

Video link: https://youtu.be/XoaZj22i3c8 Filename:  video 6 what sells your book.mp4

--------------------

Glorybound Publishing 
439 S. 6th St. Camp Verde, AZ 86322

www.gloryboundpublishing.com
sheri@gloryboundpublishing.com

https://brain-e-books.com

To Order E Books




